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Documentation Notice
The information and software described in this document are furnished only under a separate agreement and
may only be used or copied according to the terms of such agreement. It is against the law to copy the
software except as specifically allowed in such agreement. Complying with all applicable copyright laws is
the responsibility of the user. Without limiting the rights under copyright law, no part of this document may be
reproduced, stored in or introduced into a retrieval system, or transmitted in any form or by any means
(electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express
written permission of Hyland Software, Inc. and/or one of its affiliates.

Hyland, OnBase, Alfresco, Nuxeo, Content Innovation Cloud, and other product or brand names are
registered and/or unregistered trademarks of Hyland Software, Inc. and its affiliates in the United States and
other countries. All other trademarks, servicemarks, trade names and products of other companies are the
property of their respective owners.

© 2026 Hyland.

The information in this document may contain technology as defined by the Export Administration Regulations
(EAR) and could be subject to the Export Control Laws of the U.S. Government including for the EAR and
trade and economic sanctions maintained by the Office of Foreign Assets Control as well as the export
controls laws of your entity’s local jurisdiction. Transfer of such technology by any means to a foreign person,
whether in the United States or abroad, could require export licensing or other approval from the U.S.
Government and the export authority of your entity’s jurisdiction. You are responsible for ensuring that you
have any required approvals prior to export.

DISCLAIMER: This documentation contains available instructions for a specific Hyland product or module.
This documentation is not specific to a particular customer or industry. All data, names, and formats used in
this document’s examples are fictitious unless noted otherwise. This document may reference websites
operated by third parties. In such a case, Hyland has no control or liability for the content of such third-party
websites. The inclusion of such a link shall not constitute an endorsement or affiliation with such a third-party
website; the reference is provided for information purposes only. If you have questions about discrepancies in
this document, please contact Hyland. Hyland customers are responsible for making their own independent
assessment of the information in this documentation. This documentation: (a) is for informational purposes
only, (b) is subject to change without notice, (c) is confidential information of Hyland Software, Inc. and its
affiliates, and (d) does not create any commitments or assurances by Hyland. This documentation is provided
“as is” without representation or warranty of any kind. Hyland expressly disclaims all implied, express, or
statutory warranties. Hyland’s responsibilities and liabilities to its customers are controlled by the applicable
Hyland agreement. This documentation does not modify any agreement between Hyland and its customers.
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What is Workflow Designer?
Workflow Designer provides administrators with the ability to graphically create queues and routes for their
workflow processes, create rules and scripts to helpmanage items as they move through queues, customize
workflow views, andmore.

InWorkflow Designer, you set queue-specific privileges that give users and groups the ability to add,
process, archive, delete, or remove workflow items.

What is a workflow view?
A workflow process view is amechanism that displays workflow items according to the view definition that
you create for your users.

Workflow views are available at the process or queue level. You can create a view for each process in your
environment. In addition, you can define a single view for each queue in a process.

InWorkflow Designer, you can configure workflow views that are preset to display only the columns your
users need to see or work with, including custom property columns. You can also predefine sort order and
grouping of items within the view. This feature saves time for users, who are no longer required tomanually
adjust the columns, sorting, and grouping each time they display search results.

When you configure process and queue views, the following conditions apply to the search results grid:

l When both user defined process and queue views are present, the queue view is the view that displays.
l When there is a user defined process view, but there are no user defined queue views, the process view
is the view that displays.

l When neither a process nor a queue view is defined, a system view displays.
l Changes youmake to views while in ImageNowExplorer orWebNowExplorer revert to the defined
process or queue view when you end a client session. To save your changes, create a private filter.

You can also define document, folder, and task views in View Designer and folder content views in
Management Console.

What is a workflow process?
A workflow process is a series of queues, routes, tasks, and rules reflecting the review path a workflow item
must take in order to meet the sign off and approval requirements of your work group.

Queues and routes are the basic building blocks of a workflow process. Queues are connected by routes, and
you can apply rules, alarms, and actions to your process in order to meet more advanced requirements. Each
department in an organization canmanage its own process.

There are threemajor types of workflow processes:
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l Ad-hoc workflow Used by dynamic workgroups that run individual processes for each item, which
typically relies heavily on e-mail and the use of alerts.

l Transaction-based workflow This is a task-based workflow that usually involves lengthy and
complicated processes, such as loan or claims processing, that involves multiple document and folder
types and a high level of customization.

l Document-centric workflow Focus is on the document as the unifying object in the workflow
process. Documents are associated with owners, applications, rules, and routes.

For example, an accounts payable process typically involves invoice processing. To review invoices
over a certain dollar amount requiring a higher level of approval, you can create your own process with
tasks and rules that capture this subset of invoices for special review.

Get started
Queue action icons

When a queue has one or more actions, you can identify which queues in the process diagram are associated
with these actions by the icons visible in the queue. The actions represented by these icons are described in
the following table.

Action Icon Icon Type Description

Enabled alarm The queue has at least one
enabled alarm.

Inactive alarm The queue has one or more
inactive alarms. No enabled
alarms are associated with the
queue.

Inbound action The queue has an inbound action.

Within queue action The queue has a within queue
action.

Outbound action The queue has an outbound
action.

Inbound and outbound actions The queue has an inbound action
and an outbound action.

Inbound and within queue actions The queue has an inbound action
and an action within the queue.
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Action Icon Icon Type Description

Within queue and outbound
actions

The queue has an action within
the queue and an outbound
action.

All three action types The queue has one of each action
type. There is an outbound,
inbound, and a within action on
this queue.

Queue menu bar
You can open a specific pane in the Queue Properties dialog box for any queue inWorkflow Designer. When
you right-click a queue, the following options are available.

Name Description

Actions Opens the Actions pane for this queue.

Alarms Opens the Alarms pane for this queue.

Appearance Opens the Appearance pane for this queue.

Applications Opens the Applications pane for this queue.

Forms Opens the Forms pane for this queue. This option is
available only when aWorksheets or Forms license
is installed on your system.

Properties Opens the Properties pane for this queue.

Queues Opens the Queues pane for this queue. This option
is available for super queues only.

Reasons Opens the Reasons pane for this queue.

Removal Opens the Removal pane for this queue.

Routes Opens the Routes pane for this queue.

Sub Queues Opens the Sub Queues pane for this pane. This
option is available for super queues only.
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Name Description

Users Opens the Users pane for this queue. This option is
available only for work and super queues.

Convert to Sub Queue Converts this queue to a sub queue. This option is
available for work queues only. At least one super
queue must exist in the process.

Convert to Work Queue Converts this queue to a work queue. This option is
available for system queues only.

Move to Process Moves this queue to another process. This option is
available for work, system, and super queues.

Workflow queue settings
The inserverWorkflow.ini file contains settings you can use to adjust some of the actions that Workflow Agent
performs.

WorkflowAgent logging
WhenWorkflow Agent starts up, a validation check is performed. If an invalid value is provided for any of
these settings, an error message is logged even when the logging level is set to 0, and the default value is
used for the setting that has an invalid value assigned to it. Use the default settings unless you encounter
performance issues in one of the action areas, such as route recall, inbound actions, within queue or archive
actions.

General settings

poll.interval
The number in seconds for the sleep duration for each worker thread servicing a queue. This is the
interval that Workflow Agent waits before starting its new work cycle.

Default value

5 seconds

Value range

Minimum 5

Maximum 60

num.workers
The number of worker threads.
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Default value

5

refresh.queue.interval.seconds
The number in seconds for how often queue information is refreshed.

Default value

600

Workload settings
The work.load setting has a default value of 100, while all of the other settings have a default value of 0. If
these settings are left at the default value of 0, then these settings inherit the same value as the value
assigned to the work.load setting. Therefore, if you want a setting to use a different value than the work.load
setting value, assign it a value other than 0 that falls within the allowed value range for that setting.

work.load
The number of items to process for each workflow action.

Default value

100

Value range

Minimum 50

Maximum 1,000

work.load.route.recall
The number of items to process for route recall actions.

Default value

0

Value range

Minimum 5

Maximum 1,000

work.load.inbound.action
The number of items to process for delayed inbound actions.

Default value

0
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Value range

Minimum 5

Maximum 1,000

work.load.within.action
The number of items to process for within queue actions.

Default value

0

Value range

Minimum 5

Maximum 1,000

work.load.removal
The number of items to delete, remove, or archive.

Default value

0

Value range

Minimum 5

Maximum 1,000

Change process diagram settings
You can change the settings for a process diagram to include gridlines, force queues and routes to snap to
gridlines, andmore. To change process diagram settings, complete the following steps.

The options on theGrid toolbar can have unexpected results so youmay want to test the effects on a small
process before trying it on a larger process as there is no undo feature inWorkflow Designer.

1. On theGrid toolbar, perform one of the following actions.

l To turn the display of the gridlines on or off for the process diagram, click the Toggle Grid
button.

l To force queues and routes to line up with the process diagram gridlines, click theSnap to Grid
button.

l To disable users frommoving any objects, such as queues or routes, on the process diagram, click
the Toggle Grid Read Only button.

l To enable shadows for objects on the process diagram, click theEnable Shadows button.
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Customize workflow settings
Customize task pane buttons

You can customize the Task pane buttons by selecting the amount of buttons to display and which buttons to
display. To customize the Task pane buttons, complete the following steps.

1. Open the workflow process for which you want to customize Task pane buttons.
2. To show the Task pane, click View > Task Pane.
3. On the Task pane, complete one or both of the following actions.

l To show more or fewer task pane buttons, click theConfigure buttons drop-down and then click
Show More Buttons orShow Fewer Buttons.

l To add or remove task pane buttons, click theConfigure buttons drop-down, point toAdd or
Remove Buttons, and then click Queues, Routes, orActions.

Define sort order of a workflow view
You can preset the order of workflow item sorting as part of a view definition. To define the sort order of a
workflow view, complete the following steps.

1. InWorkflow Designer, double-click the workflow queue.
2. In theView Previewwindow, right-click the heading of the column on which you are sorting.
3. Click Sort Ascending orSort Descending.

Turn workflow pane auto hide on
You can configure workflow panes to hide automatically when you are not using them. To turn workflow pane
auto hide on, complete the following steps.

1. In the Task pane, click theAuto Hide button.
2. In theOverview pane, click theAuto Hide button.
Result If the pin button shows the pin facing down, auto hide is off.

Next If the pane is docked, hold themouse button over the pane tab on the left side of the workflow grid until
the pane is undocked.

Delete text or comments from a process
To delete text or comments from aworkflow process, complete the following step.

1. InWorkflow Designer, in the process diagram, select the text or comments box that you want to
delete.

2. Press DELETE.
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Enable a removal method
You can enable Perceptive Content to automatically archive, remove, or delete items from aworkflow queue
after a specified amount of time. To enable a removal method, complete the following steps.

When you select the Archive or Remove from workflow method, the document or folder associated with the
item remains in the Perceptive Content system.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Removal.
3. In the right pane, underSelect a removal method below, complete one of the following actions.

Situation Steps

To allow an item to stay in the queue indefinitely. l Select None.

To remove the item but retain the item history for
reporting purposes.

l Select Archive. Note that archiving may not
occur when aWithin Queue action is set for
the queue.

To remove the item and its history from workflow. l Select Remove from workflow.

To delete the item, item history, and associated
document from Perceptive Content.

l Select Delete from system.

4. UnderSelected removal method will be applied for items older than, set theDays, Hours, or
Minutes that an item remains in this queue before it is archived, removed, or deleted.

Queues
Workflow queue settings
The inserverWorkflow.ini file contains settings you can use to adjust some of the actions that Workflow Agent
performs.

Workflow Agent logging

WhenWorkflow Agent starts up, a validation check is performed. If an invalid value is provided for any of
these settings, an error message is logged even when the logging level is set to 0, and the default value is
used for the setting that has an invalid value assigned to it. Use the default settings unless you encounter
performance issues in one of the action areas, such as route recall, inbound actions, within queue or archive
actions.

General settings

poll.interval
The number in seconds for the sleep duration for each worker thread servicing a queue. This is the
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interval that Workflow Agent waits before starting its new work cycle.

Default value

5 seconds

Value range

Minimum 5

Maximum 60

num.workers
The number of worker threads.

Default value

5

refresh.queue.interval.seconds
The number in seconds for how often queue information is refreshed.

Default value

600

Workload settings

The work.load setting has a default value of 100, while all of the other settings have a default value of 0. If
these settings are left at the default value of 0, then these settings inherit the same value as the value
assigned to the work.load setting. Therefore, if you want a setting to use a different value than the work.load
setting value, assign it a value other than 0 that falls within the allowed value range for that setting.

work.load
The number of items to process for each workflow action.

Default value

100

Value range

Minimum 50

Maximum 1,000

work.load.route.recall
The number of items to process for route recall actions.



Workflow Designer User Guide

19

Default value

0

Value range

Minimum 5

Maximum 1,000

work.load.inbound.action
The number of items to process for delayed inbound actions.

Default value

0

Value range

Minimum 5

Maximum 1,000

work.load.within.action
The number of items to process for within queue actions.

Default value

0

Value range

Minimum 5

Maximum 1,000

work.load.removal
The number of items to delete, remove, or archive.

Default value

0

Value range

Minimum 5

Maximum 1,000
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Drawa container around queues
Containers let you highlight one or more queues to indicate a relationship or grouping between them. If you
havemany queues in a process, this color-coding optionmakes it easier to identify parts of your process
quickly. To draw a container around queues, complete the following steps.

1. On theGrid toolbar, click Draw Container.
2. Click and drag around the queues to draw a container.
3. Optional. To change the default container background or border color, complete the following substeps.

1. Verify that theBox Properties pane is displayed. If it is not displayed, click View > Box
Properties.

2. Select the container you want to change.
3. In theBox Properties pane, underBox Color, select aBackground orBorder color.

Turn on queue shadoweffect
To create a three-dimensional effect on each workflow object in a process diagram, complete the following
step.

l On theGrid toolbar, click the Enable Shadows button.

Application plans
Enable application plan linking on a queue
Enabling application plan linking on a queue allows your application plan to assign location, folder, and
document property values to captured documents within the queue. To enable application plan linking on a
queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Applications.
3. In the right pane, click theApplication Plans tab.
4. Select theAllow linking from this queue check box.
5. In theAvailable Plans list, select the application plan you want to link from, and then click Add.

Repeat this step for each application plan you want.
Selecting this check box prevents overwriting the existing values in any of the document keys. This
includes replacing an existing value with no value. Without this selected, every key is updated, based
on the configuration of the application plan, even if a field is undefined in the application plan. An
undefined key will overwrite (null) a value stored from the capture profile.

6. Optional. Click theKey Attributes tab and select theUpdate only empty key values check box.
7. Optional. Modify the key attributes privileges if needed. Key attributes include Location, Name,

Field1, Field2, Field3, Field4, Field5, Type, andDocument and Folder Custom Properties.
l To enable an attribute setting, click the column in front of the attribute until the green icon appears.
l To disable an attribute setting, click the column in front of the attribute until there is no green icon.

8. Click OK.
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Enable application plan validation on a queue
Enabling application plan validation on a queue allows Perceptive Content to validate workflow items against
your application plan when they are routed forward or back in the workflow process. To enable application plan
validation on a queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Applications.
3. In the right pane, click theApplication Plans tab.
4. UnderHost Validation, select theValidate workflow items against application plan when routing

forward check box if you want the document key validated when workflow items are routed forward to
the next queue in the process.

5. Select theValidate workflow items against application plan when routing back check box if you
want the document key validated when workflow items are routed back to the queue they last came
from in the process.

6. In theValidation application plan list, select the application plan you want to use for validation.
Selecting this check box prevents overwriting the existing values in any of the document keys. This
includes replacing an existing value with no value. Without this selected, every key is updated, based
on the configuration of the application plan, even if a field is undefined in the application plan. An
undefined key will overwrite (null) a value stored from the capture profile.

7. Optional. Click theKey Attributes tab andmodify the key attributes privileges if needed. Key attributes
include Location, Name, Field1, Field2, Field3, Field4, Field5, Type, andDocument and Folder
Custom Properties.
l To enable an attribute setting, click the column in front of the attribute until the green icon appears.
l To disable an attribute setting, click the column in front of the attribute until there is no green icon.

8. Click OK.

Modify application plan key attributes
You canmodify the application plan key attribute settings for a queue tomake the fields modifiable, allow
them to remain blank, and to allow host entry validation. Tomodify application plan key attributes, complete
the following steps.

Prerequisite Youmust enable application plan linking or application plan validation on the queue for these
settings to take effect.

1. InWorkflow Designer, double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Applications, and then in the right pane,

click theKey Attributes tab.
3. Optional. Select theUpdate only empty key values check box.

Selecting this check box prevents overwriting the existing values in any of the document keys. This
includes replacing an existing value with no value. Without this selected, every key is updated, based



Workflow Designer User Guide

22

on the configuration of the application plan, even if a field is undefined in the application plan. An
undefined key will overwrite (null) a value stored from the capture profile.

4. Modify the key attributes privileges if needed. Key attributes include Location, Name, Field1, Field2,
Field3, Field4, Field5, Type, andDocument and Folder Custom Properties.

l To enable an attribute setting, click the column in front of the attribute until appears.
l To disable an attribute setting, click the column in front of the attribute until there is no green icon.

Note: Modifying settings for the Locationattribute affects theDrawer andPath fields in the
Properties pane in ImageNowViewer andWebNowViewer. For example, with the appropriate
privileges in place, enabling theModifiable setting allows the user to move a document from a drawer
to a folder from theProperties pane. After a user saves the path, thePath field replaces theDrawer
field.

5. Click OK.

Work with processes
What is a workflow process?

A workflow process is a series of queues, routes, tasks, and rules reflecting the review path a workflow item
must take in order to meet the sign off and approval requirements of your work group.

Queues and routes are the basic building blocks of a workflow process. Queues are connected by routes, and
you can apply rules, alarms, and actions to your process in order to meet more advanced requirements. Each
department in an organization canmanage its own process.

There are threemajor types of workflow processes:

l Ad-hoc workflow Used by dynamic workgroups that run individual processes for each item, which
typically relies heavily on e-mail and the use of alerts.

l Transaction-based workflow This is a task-based workflow that usually involves lengthy and
complicated processes, such as loan or claims processing, that involves multiple document and folder
types and a high level of customization.

l Document-centric workflow Focus is on the document as the unifying object in the workflow
process. Documents are associated with owners, applications, rules, and routes.

For example, an accounts payable process typically involves invoice processing. To review invoices
over a certain dollar amount requiring a higher level of approval, you can create your own process with
tasks and rules that capture this subset of invoices for special review.
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Create a workflow process
A workflow process contains a series of tasks and rules reflecting the review path a workflow itemmust take
in order to meet the sign off and approval requirements of your work group. To create a workflow process,
complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
3. In the right pane, on theWorkflow tab, click New.
4. In theAdd Process dialog box, type a name and an optional description.

The description appears in the ToolTip for the process.
5. Click OK.
Next Create queues, routes, and rules to define the components in your new workflow process inWorkflow
Designer.

Create a process view
A workflow process view displays workflow items according to the view definition that you create for your
users at the process level inWorkflow Designer. To create a workflow process view, complete the following
steps.

1. InWorkflow Designer, click File > Properties.
2. In theProcess Properties dialog box, in theName box, type a unique name.
3. Optional. In theDescription box, type a short description.
4. UnderAppearance, complete one or more of the following actions:

Situation Action

Set preferences for how columns and statistics
display in the view

1. Click the Preview button.
2. In the View Previewwindow, make any

needed adjustments, such as adding or
resizing columns.

3. ClickOK.

Set maximum results that display in the view l In theMaximum results list, type or select
a number.

Set the view to automatically run l Select theAutomatically run this view
check box.

Restore the default view, which removes your
changes

l Click theRestore Default View button.

5. Click OK.
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Rename a workflow process
To change the name of a workflow process, complete the following steps.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
3. In the right pane, on theWorkflow tab, select a process and then click Rename.
4. Enter a new name for your process.

Modify a workflow process
Tomodify a workflow process, complete the following steps.

Prerequisite All other users must close the process.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
3. In the right pane, on theWorkflow tab, select a process and then click Modify.
4. When you are finishedmodifying your workflow process, closeWorkflow Designer.

Delete a workflow process
To delete a workflow process and remove all workflow items in its associated queues from workflow,
complete the following steps.

Prerequisite All users must close the process before it can be deleted.

1. InManagement Console, in the left pane, underSelect Department, select a department from the
list.

2. In the left pane, clickWorkflow.
3. On theWorkflow tab, select a process and then click Delete.
4. In theDelete Process confirmation box, to remove items from the queues in this process and then

delete the process, select theRemove all items from workflow and then delete this process
check box and then click Yes.

Hide Workflow Designer components
When you work with a process, you can hide components such as comments, containers, and routes. To hide
Workflow Designer components, complete the following steps.

When you open a process, all components are selected and appear inWorkflow Designer by default.

1. InWorkflow Designer, on theViewmenu, point toComponents and complete one or more of the
following actions.
l To hide all comments that appear in a process, clear theComments check box.
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l To hide all containers that appear in a process, clear theContainers check box.
l To hide routes, point toRoutes and then clear theAuto, Conditional, Conditional Parallel, or
System check box. To hide all routes in the process, clear theAll check box.

l To hide all text that appears in the process, clear the Text check box.

Add text or comments to a process
You can add text or comments to a workflow process to provide supporting information relating to the
process. The Text option adds text to the process diagram, while the Comment option adds text with a
surrounding border. To add text or comments to a workflow process, complete the following steps.

1. On theGrid toolbar, perform one of the following actions.
l Click theAdd Comment button.
l Click the Text button.

2. Click and drag a text box in the area you want to add text.
3. Perform one of the following actions.

l To add a text that is not a comment, double-click inside the box in order to begin typing.
l To add a comment, type your message.

4. Click outside of the text box to see your results.

Create a route between processes
A route can connect a workflow queue in one process to a workflow queue in a different process. To create a
route between workflow processes, complete the following steps.

1. InWorkflow Designer, complete the following substeps.
1. Double-click the queue from which you want to start the route.
2. In theQueue Properties dialog box, in the left pane, click Routes.
3. On theRoutes Out tab, click Add.
4. In theAdd Route Out dialog box, click theDestination tab.
5. In theBusiness Process list, click the process to which you want to create a route.
6. UnderAvailable queues, select the queue you want to route to and click Add.
7. Repeat the previous substeps for each queue to which you want to create a route.

2. Click OK twice.

Use overview pane to locate queues
The workflow Overview pane helps you locate specific objects on process diagrams quickly. To use the
Overview pane to locate queues, complete the following steps.

1. In theOverview pane, use the scrollbars to locate the area of the process diagram you want to access.
2. In the pane, click that area tomove to the corresponding area on the process diagram.



Workflow Designer User Guide

26

Print a workflow process
To print a copy of the workflow process as it appears on the process diagram, complete the following steps.

1. To print the workflow process, click File > Print.
2. On thePrint dialog box, make any desired changes to the print properties and settings and then click

OK.

Zoom in or out of process diagram
To zoom in on or out of a process diagram, complete the following steps.

1. On theGrid toolbar, perform one of the following actions:
l Click the Zoom In button.
l Click the Zoom Out button.

2. Repeat the previous step to continue zooming in or out until you reach the desired zoom level.

Export a process drawing
FromWorkflow Designer, you can export workflow process drawings to bitmap files. To export a process
drawing, complete the following steps.

1. InWorkflow Designer, click File > Export.
2. In theSave As dialog box, complete the following substeps.

1. In theSave in list, select the location to which to save the exported file.
2. In the File name list, type a file name.
3. In theSave as type list, verify that Bitmap is selected.
4. Click Save.

3. CloseWorkflow Designer.

Work with queues
What is a queue?

Queues are one of the basic building blocks of a workflow process.

A workflow process is comprised of queues and routes that move items through your business processes. A
workflow item is the base component for workflow and it references a specific document or folder in
Perceptive Content. It is routed from queue to queue until it reaches its destination. These queues are linked
by routes.

Automated system queues - An Automated system queue (ASQ) is a predefined queue that performs a
specific action. For example, a Content ASQ automatically submits items to Content Server. A Transfer ASQ
sends items in the queue to the Object StorageManager set that you specify when creating the queue.
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l Super queues - A Super queue redistributes workflow items to a collection of distinct queues that
perform the sameworkflow function. These sub queues reduce the number of alarms, routes, and rules
needed.

l System queues - A System queue performs an action that does not require user intervention. For
example, a queue that automatically prints documents or faxes. The action is usually performed with a
rule or script.

l Work queues - A Work queue is a queue that is assigned to one or more users who are performing the
same action upon the sameworkflow items within the queue.

l Complete queue property - This queue property sets the queue as the final queue in a process.
Any work, system, or super queue is allowed to be a Complete queue.

l Join queue property - This queue property rejoins workflow items that have been routed in parallel.
Any work, system or super queue is allowed to be a Join queue.

What is a super queue?
A super queue is a queue that redistributes workflow items to a distinct collection of sub queues that perform
the sameworkflow function.

Super queues reduce themanagement of alarms, routes, actions, and rules by centralizing the administration
of the queues contained within the super queue. The queues within a super queue are unique queues that
work in parallel to process documents for a specific business function. For example, AP approval is a specific
business function.

Super queues provide the following benefits:

l Shorter process setup times
l Significant reduction in themanagement overhead for queues, alarms and routes
l Sub queues are transparent to the workflow user
l Sub queue users are automatically assigned the necessary privileges
l Sub queues can be createdmanually or automatically

What is queue conversion?
The queue conversion tool allows you to easily redesign an existing workflow process.

You can use the queue conversion tool to convert a work queue to a sub queue or to convert a system queue
to a work queue within the same process. The work queue to sub queue conversion is used to simplify a
workflow process. You can convert multiple work queues that are performing the same function to sub queues
by adding them to a super queue. The system to work queue conversion provides additional flexibility for
changing a process. Use this conversion type when you want the ability to scan into a system queue.

As part of the conversion process, workflow items that exist in the work and system queues are transferred to
the new queue type. Additionally, after the conversion process completes, the work and system queues are
removed from the process and no longer appear inWorkflow Designer.
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Types of queue actions
Use queue actions when you want specific events to occur on workflow items. You can assign three types of
actions to queues: the inbound queue action, the within queue action, and the outbound queue action. The
following table describes these action types inmore detail.

Inbound queue action

Inbound actions are applied as workflow items enter the queue. You can specify an interval of time to
wait before the inbound action occurs by selecting or entering a number in the Process after box and
designating the period, such as minutes or seconds in the Period box. Youmust enter a number larger
than zero in the Process after box. The workflow item does not display to users as being in this queue
until the inbound action is executed.

You can use iScript for inbound actions but not workflow rules.

If you have a case where one document key value is updated based on the value of another document
key. For example, if Field3 = X, set Field1 to Y.

Within queue action

Within queue action are applied as workflow items remain in the queue for a specified interval of time.
Specify the interval unit in minutes, hours, or days in theWaiting Period section.

You can either use iScript or workflow routing rules.

To route a workflow item to different queues based on a condition or set of conditions, you can construct
a conditional routing rule for the routing queue that accomplishes this action.

Outbound queue action

Outbound actions apply as items leave the queue.

You can use iScript for outbound actions, but not for workflow rules.

If you need a stamp annotation added to each workflow item as it leaves the queue, you can write an
iScript to accomplish this action.

What are automated system queues?
Automated system queues (ASQs) are queues that perform a specific action on the items you route to them.

ASQs automate actions that previously required a custom iScript. The Content ASQ submits items to
Content Server the Transfer ASQ saves documents in anOSM set specified by the queue, and the Convert
Form ASQ converts supplemental and stand-alone forms from HTML to TIF.
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ASQs appear in the Queues pane inWorkflow Designer and require minimal configuration. To configure an
ASQ, you select the process and queue to which to send items when the automated action is complete. You
can route items to ASQs using all of the supported routing options, including sequential, sequential auto,
parallel, or parallel conditional routes. Depending on the action ASQ performs, youmight require additional
product installation and licensing. For example, to submit items to a Content ASQ, youmust install and
license Content Server. If you do not have a Content Server license, the Content ASQ does not appear in
Workflow Designer.

What are Connect ASQs?
The Connect automation system queue (ASQ) sends web service notifications to your business applications.

Suppose you are the AP Manager and want to reduce the time and cost associated with processing invoices.
Tomeet these requirements, you implement an Connect ASQ. As an invoice enters this queue, Perceptive
Content sends a web service notification to the business application URI (Uniform Resource Identifier). The
business application receives the data you configure, such as invoice header andGL distribution information,
and creates the necessary payables invoice transaction, payment batch, and associated GL distributions.
Your business application can route the item to the success or failure queue depending on the process results
using a route itemmessage sent to Integration Server.

To use the Connect ASQ, youmust configure the connect.uri setting in the inserverWorkflow.ini file, to define
the REST endpoint that is invoked for each item in the queue. If the connect.uri setting is not present, the
Connect ASQ queue displays but does not process any items. Additionally, to access Perceptive Content
from your business application, youmust have an Integration Server license.

What are Convert Form ASQs?
A Convert Form ASQ is a queue that converts stand-alone and supplemental form types from HTML to TIF.

Converting a form to TIF gives you the ability to annotate or email that form. For example, suppose you are
the director of HR and your department uses a form to capture employee 401K benefit information. When an
employee requests a copy of this information, you can email him or her the TIF version of the form.

Workflow Designer's Convert Form ASQ functionality uses form sets to determine which forms to convert. To
define a set, you select a form and the presentation template for the TIF. You can define an unlimited number
of form sets for each Convert Form ASQ. If you route a form to a Convert Form queue and no form set for that
form exists, the conversion process does not occur and Perceptive Content routes the form to the Success
Action queue.

After the conversion process is complete, Perceptive Content appends the TIF to the original form. The form
type determines the page placement of the TIF.

Convert an Integration ASQ to a Connect ASQ
To send web service notifications from Perceptive Content youmust use a Connect ASQ. You have the
option to convert Integration ASQs to Connect ASQs using the inUpgradeUtil convert-integration-
queues command. To run the inUpgradeUtil convert-integration-queues command complete the
following steps.

1. On thePerceptive Content Servercomplete one of the following actions.
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l InWindows 32-bit, open a Command Prompt window and change to the [drive:] \inserver\bin
directory.

l InWindows 64-bit, open a Command Prompt window and change to the [drive:]\inserver\bin64
directory.

l In Unix, change to the $(IMAGENOWDIR)/bin directory.

Note: To view detailed information about a specific inUpgradeUtil command, at the prompt enter
inUpgradeUtil --cmd-help convert-integration-queues. For more information, see
the Run INUpgradeUtil commands topic of Manage Content help.

What are Integration ASQs?
Creation of new Integration ASQs has been deprecated for Perceptive Content 7.2.1 and future versions.
Existing Integration ASQs can bemodified but new Integration ASQs cannot be created. To send web service
notifications from Perceptive Content youmust use a Connect ASQwhich supports the use of REST APIs
instead of SOAP. Existing Integration ASQs can be converted to Connect ASQs utilizing the
inUpgradeUtil convert-integration-queuescommand.

The Integration automation system queue (ASQ) sends web service notifications to your business
applications.

Suppose you are the AP Manager and want to reduce the time and cost associated with processing invoices.
Tomeet these requirements, you implement an Integration ASQ. As an invoice enters this queue, Perceptive
Content sends a web service notification to the business application URI (Uniform Resource Identifier) using
the Envoy service operation name you define. The business application receives the data you configure, such
as invoice header andGL distribution information, and creates the necessary payables invoice transaction,
payment batch, and associated GL distributions. After this process is complete, your business application
sends a success response usingMessage Agent, and Perceptive Content routes the invoice to the success
queue.

To use the Integration ASQ, youmust have an Envoy license. If this license is not present, the Integration
ASQ queue displays but does not process any items. Additionally, to access Perceptive Content from your
business application, youmust have aMessage Agent license.

What are ASQ consumable operations?
ASQ consumable operations are remote service operations that can be consumed by an Integration ASQ.

Integration ASQs can consume any remote service operation that meets the following parameter
requirements:

l Must have nomore than 128 characters.
l Must include ITEM_ID, QUEUE_ID, QUEUE_NAME, FAILURE_QUEUE_ID, FAILURE_QUEUE_
NAME, SUCCESS_QUEUE_ID, and SUCCESS_QUEUE_NAME.

Using the URI you provide, Envoy service retrieves a list of all remote service operations associated with that
URI. All ASQ consumable operations are displayed in bold.
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Integration ASQ parameter map variables
When you route an item to the Integration ASQ, you can use a parameter map to send properties associated
with that item to the web service endpoint. The Integration ASQ supports a predefined list of document, folder,
workflow item, and custom property variables.

Note: Creation of new Integration ASQs has been deprecated for Perceptive Content 7.2.1 and future
versions. Existing Integration ASQs can bemodified but new Integration ASQs cannot be created. To send
web service notifications from Perceptive Content youmust use a Connect ASQwhich supports the use of
REST APIs instead of SOAP. Existing Integration ASQs can be converted to Connect ASQs utilizing the
inUpgradeUtil command.

Custom Property Variables
This table lists and describes custom property data types. You canmap all custom property data types
except a composite property or an array of properties from an Integration ASQ.

Data Type Description

Date Represents a date value

Flag Represents a boolean value

List Represents a predefined list value

Number Represents a decimal number value

String Represents a text field value

User Represents a user name value

Document Variables
This table lists document variables and their descriptions.

Variable Name Description

Drawer Represents the Drawer value

Field1 Represents the Field1 value

Field2 Represents the Field2 value
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Variable Name Description

Field3 Represents the Field3 value

Field4 Represents the Field4 value

Field5 Represents the Field5 value

Type Represents the document type

Name Represents the document name

Creation Time Represents the document creation time

Notes Represents the notes associated with a document

Folder Variables
This table lists folder variables and their descriptions.

Variable Name Description

Type Represents the folder type

Name Represents the folder name

Creation Time Represents the folder creation time

Workflow Item Variables
This table lists workflow item variables and their descriptions.

Variable Name Description

Workflow Item Type Represents the item type: document or folder

Object ID Represents the document or folder ID

Added toWorkflow Represents the time when a document or folder was
added to workflow

Queue Start Time Represents the time when an item was added to the



Workflow Designer User Guide

33

Variable Name Description

current queue

Routed From Represents the queue from which the item was last
routed

Workflow By Represents the name of the user who added or
routed the item to the current queue

Priority Represents the item priority: high, normal, or low

Form types and Convert Form ASQs
This table lists each type of form and describes the page placement for that form type after it is converted
from HTML to TIF using a Convert Form ASQ.

Form Type Page Placement

Stand-alone form (no attachments) Appends the TIF to the form as page 2.

Stand-alone form (with attachments) Appends the TIF to the form as the last page.

Supplemental form Appends the TIF to the form as the last page.

Manage users
Add a user to a queue
To add a user or group to a workflow queue and assign queue privileges, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, select Users and then click Add.
3. Perform one of the following actions.

l On theUsers tab, underAvailable Users, select a user and then click Add.
l On theGroups tab, underAvailable Groups, select a group and then click Add.

4. Click OK.
5. In theQueue Properties dialog box, click under the column for the privilege you want to assign to the

user or group.
6. Click OK.



Workflow Designer User Guide

34

Promote user to queue lead
When you designate users as Queue Leads, you grant them all privileges for the queue and authorize them to
change the status of workflow items to "Idle." To promote a user to Queue Lead, complete the following
steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, select Users.
3. Select the user or group and then click Promote.
4. Click OK.

Remove a user from a queue
To remove a user from aworkflow queue, complete the following steps.

1. Double-click the queue you want.
2. In theQueue Properties dialog box, in the left pane, select Users.
3. Select the user or group and then click Remove.
4. Click OK.

Create queues
Create a work queue
AWork queue is a queue that is assigned to one or more users who are performing the same action upon the
sameworkflow items within the queue. To create aWork queue, complete the following steps.

This procedure outlines theminimal steps required to create a work queue.

1. InWorkflow Designer, in the left pane, underQueues, select theWork queue and then drag it to the
right in your process diagram.

2. Double-click the queue tomodify its properties.
3. In theQueue Properties dialog box, in the left pane, select Properties.
4. In the right pane, in theName box, enter the name for your work queue.
5. If you want to define a Join queue, select the Join queue check box.

Note: A Join Queue is one that rejoins a workflow item that you route in parallel by creating two or
more copies (siblings) of the original item. When they arrive in the Join queue, the items are rejoined as
the one workflow item that existed prior to the split.

6. To define this queue as the last queue in the process, select theComplete queue check box.
As an item is routed into aComplete queue, its status is then changed to "completed."

7. Click OK.
8. Repeat these steps for each work queue you want to use in your process.
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Create a super queue
A Super queue redistributes workflow items to a collection of distinct queues that perform the sameworkflow
function. These sub queues reduce the number of alarms, routes, and rules needed.

1. InWorkflow Designer, in the left pane, underQueues, click Super and drag it to the right in your
process diagram.

2. Double-click the queue tomodify its properties.
3. In theSuper Queue Properties dialog box, in the left pane, click Properties.
4. In the right pane, in theName box, enter the name for your super queue.
5. In the left pane, click Sub Queues.
6. In the right pane, click New.
7. In theNew Sub Queues dialog box, complete one of the following actions.

Situation Action

Create manual queues 1. On theGeneral tab, clickManual queue
creationand type a name in theName box.

2. On theUsers and Groups tab, clickAdd.
3. In the Select Users and Groups dialog box,

on theUsers tab, select each user you want to
assign to this queue, clickAdd, and then click
OK.

4. In the Select Users and Groups dialog box,
on theGroups tab, select each group you want
to assign to this queue, clickAdd, and then
clickOK.

Create automatic queues, which creates a
separate queue for each selected user and
group using their user or group name for the
subqueue name.

1. On theGeneral tab, clickAutomatic queue
creation so that the queue is named for you by
Workflow Designer.

2. On theUsers and Groups tab, clickAdd.
3. In the Select Users and Groups dialog box,

on theUsers tab, select each user you want to
assign to this queue and clickAdd.

4. In the Select Users and Groups dialog box,
on theGroups tab, select each group you want
to assign to this queue, clickAdd, and click
OK.

8. Click OK.
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Create a system queue
A System queue performs an action that does not require user intervention. For example, a System queue
may be a queue that automatically prints documents or faxes. The action is usually performed with a rule or
script. To create a system queue, complete the following steps.

This procedure outlines theminimal steps required to create the different queue types. For setting some of the
more advanced queue properties, refer to the topics in the Queue Properties section.

1. In theWorkflow Designerwindow, in the left pane, underQueues, select theSystem queue and then
drag it to the right in your process diagram.

2. Double-click the queue tomodify its properties.
3. In theQueue Properties dialog box, in the left pane, select Properties.
4. In the right pane, in theName box, enter the name for your system queue.
5. In the left pane, click Actions.
6. In the right pane, on the Inbound,Within Queue, orOutbound tab, in theAction list, select the script

or rule you want to use.
7. Click OK.
8. Repeat these steps for each system queue you want to use in your process.

Create a transfer queue
A Transfer queue is an Automated System Queue that sends items in the queue to the Object Storage
Manager (OSM) set that you specify when creating the queue. To create a Transfer queue, complete the
following steps.

Prerequisite Before performing this procedure, youmust create two queues: one queue for successful
transfers to the OSM set and another queue for processing unsuccessful transfers.

1. InWorkflow Designer, in the left pane, underQueues, select the Transfer automated system queue
and then drag it to the right in your process diagram.

2. Double-click the queue tomodify its properties.
3. In theQueue Properties dialog box, in the right pane, underDetails, in theName box, enter the name

of the queue.
4. UnderAutomated Action, complete the following substeps.

1. To designate the process and queue for items successfully processed in this queue, in the
Success Action list, select a process in theProcess list and then select a queue in theQueue
list.

2. To designate the process and queue for items that are not successfully processed in this queue,
in the Failure Action list, select a process in theProcess list and then select a queue in the
Queue list.

Note: The transfer queue references the OSM set by name. Ensure the target OSM set and the
original OSM set are named identically.

5. In theOSM list, select theOSM set in which ImageNow Server saves the documents.
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Create a Connect ASQ
A Connect automated system queue (ASQ) is a queue that sends web service notifications to any business
application. To create a Connect ASQ, complete the following steps.

Prerequisite Before performing this procedure, youmust create two queues: one queue for successfully
processed items and another queue for processing unsuccessful items.

This procedure assumes there is a configured connect.uri setting in the inserverWorkflow.ini file that defines
the REST endpoint invoked for each item in the queue.

1. In theWorkflow Designerwindow, in the left pane, underQueues, select Connect ASQ and drag it to
the right in your process diagram.

2. Double-click the queue tomodify its properties.
3. In theQueue Properties dialog box, in the right pane, underDetails, in theName box, enter the name

of the queue.
4. UnderAutomated Action, complete the following substeps.

1. To designate the process and destination queue for items successfully processed in this queue,
in theSuccess Action list, select a process in theProcess list and select a queue in theQueue
list.

2. To designate the process and destination queue for items that are not successfully processed in
this queue, in the Failure Action list, select a process in theProcess list and select a queue in
theQueue list.

3. To set the number of days that items remain in this queue after the business application receives
a successful call for those items, in theRoute After (Days) box, type a number.
By default, Perceptive Content routes items to the failure queue after one day. If your business
application does not place a web service call for an item, that item remains in the Connect ASQ
for the number of days you specify in theRoute After (Days) box.

Note: You cannot assign a sub queue as a success or failure action queue.

5. Click OK.

Create a Convert Form ASQ
A Convert Form queue is an Automated System Queue (ASQ) that converts stand-alone and supplemental
form types from HTML to TIFF. Converting a form to TIFF gives you the ability to annotate or email that form.
To create a Convert Form ASQ, complete the following steps.

Prerequisite Before performing this procedure, youmust create two queues: one queue for successful
conversions and another queue for processing unsuccessful conversions.

1. InWorkflow Designer, in the left pane, underQueues, select theConvert Form automated system
queue (ASQ) and then drag it to the right in your process diagram.

2. Double-click the queue tomodify its properties.
3. In theQueue Properties dialog box, underDetails, in theName box, enter the name of the queue.
4. UnderAutomated Action, complete the following substeps.
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1. To designate the process and queue for items successfully processed in this queue, in the
Success Action list, select a process in theProcess list and then select a queue in theQueue
list.

2. To designate the process and queue for items that are not successfully processed in this queue,
in the Failure Action list, select a process in theProcess list and then select a queue in the
Queue list.
You cannot assign a sub queue as a success or failure action queue.

3. To create a form set, underSelect Form and Presentation, click Add.
4. To designate the form to convert, select a form in the Form list and then to designate the

presentation template for the TIFF, select a presentation in thePresentation list.
If a form does not have any associated presentations, that form does not appear in the Form list.
Only presentations assigned in theComponents pane for a form appear in thePresentation list.

5. Optional. To create additional forms sets, click Form and Presentation and then in the right column,
click the Insert Form Set+ button. Repeat the previous substep to complete the form set.

6. Optional. To prevent a custom javascript from rendering during the conversion process, under
Conversion Options in theExecute Javascript list, select Disabled.
Disabling javascript on a form in this queue ensures that the server does not become unresponsive
while waiting for the javascript to load. However, disabling javascript may also cause the system to
convert the form without populating all of the appropriate data.

7. Click OK.

Modify queues
About copying queues
The copy queue functionality allows you to copy one or more queues within the same process.

You can copy work, system, super, and automated system queues. In addition to copying the queue, you can
copy all queue property components, such as actions, alarms, reasons, and users, or just the components
you need. The paste option you select determines the components you copy.

About moving queues
Themove functionality inWorkflow Designer allows you tomove a queue from its current process to any
process in your system.

When youmove a queue, Workflow Designer retains that queue's property components, such as alarms,
routes, and users. You canmove automated system (ASQ), work, system, and super queues. Use themove
functionality when you want to reuse your existing queues.

For example, suppose you are the Accounts Payable (AP) director and your current AP process contains
work queues for both the AP and Accounts Receivable (AR) departments. You decide to create a separate
process for the AR department. Instead of recreating queues, routes, and queue properties for the new AR
process, you can simply move the AR department queues from the AP process to the AR process. Because
themove functionality preserves the users, routes, and alarms, the AR department can immediately begin to
use the new AR process.
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Rename a queue
To rename a queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in theName field, select the existing text, and then type your new

queue name.
3. Click OK.

Copy a queue
You can copy a queue and all related components except for in routes. To copy a queue, complete the
following steps.

1. In theWorkflow Designer process diagram, select one or more queues to copy, right-click, and then
click Copy.

2. Move the pointer to an empty space in the process diagram, right-click, and then complete one of the
following actions.

Situation Steps

To copy all components to the new queue l ClickPaste.

To select the components you want to copy to
the new queue

1. ClickPaste Special.
2. In the Paste Special dialog box, under

Select a queue component, clear the
check boxes for the components you do not
want to copy.

3. ClickOK.

The new queue appears in the process diagram. If you selected the Routes component in the previous
step, defined out routes also appear.

Delete a queue
To delete a workflow queue, complete the following steps.

1. In the process diagram, select the queue you want to delete and then press DELETE.
2. In the confirmation prompt, click Yes.

Modify a sub queue on a super queue
Tomodify a sub queue on a super queue, complete the following steps.

1. Double-click the super queue.
2. In theSuper Queue Properties dialog box, in the left pane, click Sub Queues.
3. In the right pane, select the sub queue you want to modify and then click Modify.
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4. Modify the following settings as needed.
l In theModify Sub Queue dialog box, on theGeneral tab, type a new name for your sub queue in
theName box.

l On theUsers and Groups tab, select the users or groups you want to remove and then click
Remove.

l To add additional users or groups, click Add.
l In theSelect Users and Groups dialog box, on theUsers tab, search for and select the additional
users you want to have access to this sub queue, click Add, and then click OK.

l In theSelect Users and Groups dialog box, on theGroups tab, search for and select the
additional groups you want to have access to this sub queue, click Add, and then click OK.

5. In theModify Sub Queue dialog box, click OK.

Move a queue in a process
Tomove a queue to a new location in the process diagram, complete the following step.

l Select the queue you want to move and drag it to a new location in the process diagram.

Move queues to another process
You canmove work queues, system queues, and super queues between workflow processes. When you
move a queue, Workflow Designer alsomoves the in and out routes for that queue. Tomove a queue to
another process, complete the following steps.

1. In theWorkflow Designer process diagram, right-click the queues you want to move, and then click
Move to Process.

2. In theMove Queue dialog box, in theSelect a process list, select the process to which you want to
move the queue and then click OK.

Delete a sub queue from a super queue
To delete a sub queue from a super queue, complete the following steps.

1. In theSuper Queue Properties dialog box, in the left pane, click Sub Queues.
2. In the right pane, select the sub queue you want to delete and then click Delete.
3. Click OK.

Move or delete several workflow objects
You canmove or delete workflow objects individually or simultaneously. Tomove or delete multiple workflow
objects simultaneously, complete the following steps.

1. In the workflow process diagram, complete one of the following actions.
l To select several items at once, press CTRL and click each queue and route.
l Drag a box around the items you want to select.
l To select all items in the process diagram, press CTRL + A.

2. To delete the selected objects, press DELETE.
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3. In the confirmation prompt, click Yes.
4. Tomove the selected objects, hold the pointer over one of the selected item until it becomes a cross-

hair, and then drag the items where you want them in the process diagram.

Configure queues
Set a queue as a join queue
A Join queue rejoins a workflow item that you route in parallel by creating two or more copies (siblings) of the
original item. When the items arrive in the Join queue, they become one workflow item again. Any work,
system or super queue is allowed to be a Join queue. To set a queue as a Join queue, complete the following
steps.

1. Double-click the queue you want to designate as the join queue.
2. In theQueue Properties dialog box, in the left pane, select Properties.
3. In the right pane, select the Join queue check box.
4. Click OK.

Set a queue as a complete queue
A complete queue is the last queue in a workflow process. When an item reaches this queue, it's status is
"Complete." Any work, system, or super queue is allowed to be a Complete queue. To set a queue as a
complete queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Properties.
3. In the right pane, click theQueue tab.
4. Select theComplete queue check box.
5. Click OK.

Enable route back on a queue
Enabling the Route Back setting on a queue allows users to route a workflow item back to its previous queue.
To enable Route Back on a queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, select Properties.
3. In the right pane, select theAllow route back from this queue check box.
4. Click OK.

Enable route recall on a queue
Enabling the Route Recall setting on a queue allows users to recall a workflow item after it is routed to another
queue. To enable Route Recall on a queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, select Properties.
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3. In the right pane, select theEnable route recall check box.
4. In theRecall period box, type or select the number of seconds this feature is available.
5. Click OK.

Enable route from anywhere on a queue
AWorkflow Process manager may designate a work queue or system queue as a route from anywhere
destination for workflow items within the same process.

Designating a queue as a route from anywhere destination allows users with process privileges on any queue
in the process to route items from those queues to the designated queue. Users do not need the route
anywhere privilege to send items to that queue. To enable Route From Anywhere on a queue, complete the
following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, select Properties.
3. In the right pane, select theEnable queue as route from anywhere destination check box.
4. Click OK.

Enable sub queue routing on a super queue
Within a super queue, you can allow workflow item routing to occur between sub queues. With this feature
enabled, a user clicks Route Forward and routes an item to another sub queue in the Peer Routes list. To
enable sub queue routing on a super queue, complete the following steps.

1. Double-click the super queue.
2. In theSuper Queue Properties dialog box, in the left pane, verify that Properties is selected.
3. In the right pane, on theQueue tab, under theSub Queue Routing section, select theAllow routing

between sub queues check box.
4. Click OK.

Convert a work queue to a sub queue
The queue conversion tool allows you to easily redesign an existing workflow process by converting a work
queue to a sub queue. To convert a queue, complete the following steps.

Prerequisite This procedure requires a workflow process with at least one super queue.

1. Right-click the work queue you want to convert to a sub queue.
2. Point toConvert to Sub Queue and then select the super queue you want.
3. If there aremore than ten super queues in this process and you do not see the super queue you want, in

theConvert to Sub Queue list, click More.
4. In theConvert to Sub Queue dialog box, in the super queue list, select the super queue you want and

then click OK.
In the confirmation dialog box, the followingmessage appears:
A sub queue will be added to <super queue>. All process users will be
transferred to the new sub queue."
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5. Verify that the correct super queue appears and then click Convert.
The work queue you converted no longer displays inWorkflow Designer.

6. Open the super queue to which the work queue was converted.
7. In theQueue Properties dialog box, in the left pane, click Queues and verify that the work queue is

listed as a sub queue.
8. Click OK to close theQueue Properties dialog box.

Convert a system queue to a work queue
The queue conversion tool allows you to easily redesign an existing workflow process by converting a system
queue to a work queue. To convert a queue, complete the following steps.

1. Right-click the system queue you want to convert to a work queue and then click Convert to Work
Queue.
In the confirmation dialog box, the followingmessage appears:
Converting a system queue to a work queue may cause some of the actions
to fail. Please make sure the action will not interfere with user
interactions before you proceed.

2. Click Convert.
3. To confirm that the conversion was successful, double-click the queue you converted.
4. In theQueue Properties dialog box, in the left pane, verify that Properties is selected. In the right

pane, under the General section, verify that in the Type list,Work appears.
The Type list is unavailable and appears dimmed.

5. In theQueue Properties dialog box, select the options you want for this queue and click OK
Result Action pane options are not retained as part of the system to work queue conversion. Other queue
properties, including alarms, application plans, reasons, and removal options are converted. System queue
routes are retained when converted to a work queue. As part of the conversion process, workflow items that
exist in the system queue at the time of conversion are transferred to the work queue.

Associate a form with a workflow queue
When you associate a form with a queue, users can complete a form for a workflow item as part of the queue
processing. To associate a form with a workflow queue, complete the following steps.

Displaying a folder as a form replaces any forms previously attached to any workflow queue with the form you
select in this procedure.

1. InWorkflow Designer, select a queue and then press ENTER.
2. In theQueue Properties dialog box, in the left pane, click Forms.
3. You can perform the following associations.

l To attach forms to this queue, click Add, in theSelect Forms dialog box, select the forms you
want to add and then click OK.

l To remove a form from this queue, select the form in the list and then click Remove.
l To change the default form associated with this queue, select the form in the list and click Set as
Default.
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4. Repeat the previous steps for any additional queues.
5. When you are done associating forms, click OK.

Search
Search for a queue inWorkflowDesigner
To quickly locate a queue in a process, you can search by queue name. Thematching queue and its outbound
routes appear highlighted. To search for a queue, complete the following steps.

You cannot locate sub queues with this search.

1. InWorkflow Designer, on the Find toolbar, in the Find box, enter all or part of a queue name. As you
type,Workflow Designer brings thematching queue into focus in the process diagram.

2. Optional. When there is a namematch for multiple queues, to move to the next queue in alphabetical
order, click theNext button. To return to any of the previous matching queues, click thePrevious
button.

Alarms
What is a workflow alarm?
A workflow alarm can alert one or more users of a critical task that needs to be performed or that is now ready
to be performed in a queue.

You can add Email, Perceptive Content Icon, Message Center, and Audible alarms to a queue to alert users.
For example, you can send an email alarm to the AP manager if the document property value is set to Reject.
Another kind of alert could be created that would show the AP manager that an item was routed from Legal
Review to the current queue. Alarms are useful because they relieve the user from having repeated
inspections of the status of multiple queues to determine whether critical tasks have been performed within a
certain time frame.

Define conditions for a rule statement
To add conditions to a statement in a routing or alarm rule, complete the following steps.

1. InWorkflow Designer, in theActions pane, click Manage Actions.
2. Select a rule and click Modify.
3. In theRules Editor dialog box, select the statement and click Modify.
4. In theStatement Editor, underConditions, perform one or both of the following actions.

l Tomodify the existing condition, click the blue underlined text.

l To add a new condition, click theAdd button.
5. In theConstrain by list, select the kind of constraint to set up the lists you need in the Type, Field, and

Operator boxes.
6. In the Type list, verify that Normal is selected.
7. In the Field list, click the field for the comparison.
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8. In theOperator list, select the operator to use in the comparison.
9. In theValue box, enter or select a value to use with the operator when comparing against the field and

click OK.
10. Optional. Repeat these steps for any additional condition rows.

Configure email notifications
To configure the SMTP server that Perceptive Content uses to send all system email notifications, complete
the following steps.

1. On the ImageNow Server computer, navigate to [drive:]\inserver\etc.
2. Open the inserverNotification.ini file with a text editor.
3. In the [Email] section, complete the following substeps.

1. Type the server name or IP address in the smtp.server setting.
2. Type the port number in the smtp.server.port setting.

4. Save and close the inserverNotification.ini file.

[Email]

smtp.server=MailServer

smtp.server.port=25

Create an email alarm overview
An email alarm causes an email message to be sent to a person or group through an SMTP server. To create
an email alarm, complete the following steps.

1. /1.
2. /1.
3. /1.
4. /1.
5. /1.
6. /1.
7. /1.

Activate an email rule

To activate the rule you associated to an email alarm, complete the following steps.

1. InWorkflow Designer, in theActions pane, click Manage Actions.
2. Select a rule and click Modify.
3. In theStatement Editor dialog box, to create a statement for your rule, underStatements, click New
4. In theRules Editor dialog box, click Active and then click OK.
5. To close theRules Editor dialog box, click OK.
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6. In theAlarm Settings dialog box, in theAlarm Rule list, select the alarm rule you just created and
then click OK.

7. In theSelect Alarms dialog box, select the alarm you just created, and then click Add.
8. In theQueue Properties dialog box, verify that your email alarm is in the list, with a Queue Status of

Enabled and an Alarm Status of Active.
9. If you do not see theAlarm Status column, click Columns. In theColumns dialog box, select the

Alarm Status check box, and then click OK.
10. In theQueue Properties dialog box, click OK.

Create a queue link overview
To create a workflow email alarm that includes a link to the queue that triggered the alarm, complete the
following procedures.

1. /1.
2. /1.
3. /1.
4. /1.
5. /1.
6. /1.
7. /1.
8. /1.
9. /1.

10. /1.

Configure queue link settings

To configure Alarm Agent to send email notifications with workflow queue links, complete the following steps.

1. On the ImageNow Server computer, navigate to the [drive:]\inserver\etc folder.
2. Open the inserverAlarm.ini file in a text editor, and in the [Email] section, complete one of the

following actions.
l To include an Perceptive Content link, set the queue.email.link setting to 0.
l To include aWebNow link, set the queue.email.link setting to 1.
l To include both an Perceptive Content andWebNow link, set the queue.email.link setting to
2.

Example queue.email.link=0, queue.email.link=1, or queue.email.link=2

Perceptive Content applies this setting to all queue link email alarms.
3. Save and close the inserverAlarm.ini file.
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Create a queue link email alarm

To create a queue link email alarm for items that meet the conditional statements that you previously defined,
complete the following steps.

1. In theStatement Editor dialog box, underActions, click Add > Send email.
2. In theEmail Alarm dialog box, in theAlarm name box, type a name for the alarm.
3. UnderEmail Header, in the From field, type an address.
4. Optional. In the To field, type an email address. Enter addresses in this field only when you want to

email a user who is not assigned to the queue, such as a Department Manager who is not a process
user.

5. Select theEmail all users in the queue check box to email all queue users.
6. Optional. Type addresses in theCc orBcc fields as necessary.
7. UnderEmail Message, in theSubject field, click Add to Subject and in the Insert list, select the

option you want, such as Queue Name, and then click OK.
8. In theSubject field, next to%Queue_Name%, type the text you want to appear.
9. In theBody field, click Add to Body and in the Insert list, select the option you want.

10. UnderEmail Interval, set the interval for the time period you want between alarms. For testing
purposes, set the interval to 4 or 5minutes.
If you set the interval for <X> days, Perceptive Content does not send another email for 24 hours.

Create an icon alarm overview
You can create an alarm that changes the state of the Perceptive Content icon in the upper-left corner of the
Perceptive Content toolbar. When you set this alarm, the icon changes from static to flashing, in a color and
flashing frequency of your choice. To create an Perceptive Content icon alarm, complete the following
sequence of procedures.

1. /1.
2. /1.
3. /1.
4. /1.
5. /1.
6. /1.

Create aMessage Center alarm
When an alarm is assigned to aMessage Center action, the alarm presents amessage on the Perceptive
Content toolbar when a predefined condition is met in a queue. To assign an existing alarm to aMessage
Center action, complete the following steps.

1. InWorkflow Designer, double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Alarms.
3. In the right pane, click Modify.
4. In theSelect Alarms dialog box, select an alarm and click Modify.
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5. In theAlarm Settings dialog box, in theAlarm Rule list, select Edit Rules.
6. In theRules dialog box, select a rule and click Modify.
7. In theRules Editor dialog box, select a statement and click Modify.
8. In theStatement Editor dialog box, underActions, click Add > Message Center.
9. In theMessage Center Alarm dialog box, in theAlarm name box, type a name.

10. Click Add to Title.
11. In the Insert dialog box, click Queue Name > OK.
12. In theMessage Center Alarmdialog box, in theMessage Title box, after the %Queue_Name%

statement, type amessage such as Attention!
13. Click Add to Body.
14. In the Insert dialog box, click Queue Name > OK.
15. In theMessage Center Alarm dialog box, in theBody box, type some text around the query logic so

the incomingMessage Center contains a full sentence, such as There is an Invoice in the%Queue_
Name% Queue.

16. Click OK until you return toWorkflow Designer.

Create an audible alarm overview
To create an audible alarm that plays when workflow queue conditions aremet, complete the following
sequence of procedures.

1. /1.
2. /1.
3. /1.
4. /1.
5. /1.
6. /1.
7. /1.

Create an alarm rule
To create an alarm that notifies the user when certain workflow conditions aremet, complete the following
steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.
3. In theAction Settings dialog box, on theRules tab, click New.
4. In theRules Editor, in theRules name box, type a name.
5. In theRule type list, select Alarm rule.
6. Click OK until you return toWorkflow Designer.
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Change an alarm rule for a queue alarm
To change the alarm rule for a queue alarm, complete the following steps.

1. Double-click the queue you want.
2. In theQueue Properties dialog box, in the left pane, select Alarms.
3. In the right pane, in the alarms list, select the alarm you want to replace, and then click Modify.
4. On theAlarm Settings dialog box, in theAlarm Rule list, select the alarm rule you want to use

instead.
5. Click OK.

Define an audible alarm action
To define an audible action for a statement in an alarm rule, complete the following steps.

1. InWorkflow Designer, in the Task pane, click Actions.
2. In theAction Settings dialog box, on theRules tab, select the rule and click Modify.
3. In theRules Editor dialog box, underStatements, select the statement and click Modify.
4. In theStatement Editor dialog box, underActions, click Add > Play sound.
5. In theAudible Alarm dialog box, complete the following substeps.

1. In theAlarm name box, type an alarm name.
2. UnderSound Selection, select a predefined sound or browse to theWAV file location.
3. Optional. To preview the audible alarm sound, click Listen to it.
4. To set the time between each audible alarm, in the In minutes, time between play box, type a

number.
6. Click OK until you return toWorkflow Designer.

Define an icon alarm action
To define the icon behavior in a statement for an Perceptive Content icon alarm rule, complete the following
steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. In theAction Settings dialog box, on theRules tab, select the alarm rule and click Modify.
3. In theStatement Editor, select the statement and click Modify.
4. UnderActions, click Add > Flash icon.
5. In the Icon Alarm dialog box, complete the following substeps.

1. In theAlarm name box, type a name for the alarm.
2. UnderSet-up, select the color you want and then shift the Frequency slider to the frequency you

want.
3. Click OK.

6. Click OK until you return toWorkflow Designer.
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Enable or disable an alarm on a queue
To enable or disable an alarm on a queue, complete the following steps.

1. Open the process containing the queue for which you want to enable or disable an alarm.
2. Double-click the queue you want.
3. In theQueue Properties dialog box, in the left pane, select Alarms.
4. In the right pane, in the alarms list, select the alarm you want to enable or disable.
5. Complete one of the following actions.

l To enable the alarm, click Enable.
l To disable the alarm, click Disable.

Modify alarm settings
Tomodify alarm settings for an alarm assigned to a workflow queue, complete the following steps.

1. InWorkflow Designer, double-click the queue containing the alarm you want to modify.
2. In theQueue Properties dialog box, in the left pane, select Alarms.
3. In the right pane, in the alarms list, select the alarm you want to modify, and then click Modify.
4. In theAlarm Settings dialog box, modify the following settings as needed.

l In theName field, type a new alarm name.
l In the Timeout Period field, adjust the timeout period for the alarm by typing or selecting a new
timeout period.

l In theStatus field, change the alarm status by clickingActive or Inactive.
l In theAlarm Rule list, select the alarm rule you want to use instead. Select Edit Rules if you
want to create a new alarm rule to use with this alarm or edit the current alarm rule.

5. Click OK.

Remove an alarm from a queue
To remove an alarm from a queue, complete the following steps.

1. Double-click the queue you want.
2. In theQueue Properties dialog box, in the left pane, select Alarms.
3. In the right pane, in the alarms list, select the alarm you want to remove and then click Remove.

Set alarm priority for a queue
Alarms for a queue are prioritized according to the order in which the alarms are created. To change the alarm
priority for a queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, select Alarms.
3. In the right pane, in the alarms list, select an existing alarm and click either theMove Up orMove

Down button to change its priority.
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4. Repeat the previous step for each alarm until all of the alarms are ordered in your preferred priority.
Alarms have priority from the top down in the alarms list.

Showor hide alarm columns
You can determine which alarm columns display globally for all queues in all processes. To show or hide
alarm columns, complete the following steps.

1. Double-click any queue.
2. In theQueue Properties dialog box, in the left pane, select Alarms.
3. Click theColumns button.
4. In theColumns dialog box, select the check boxes for the columns you want to display and clear any

check boxes for columns you want to hide.
5. Click OK.

Test an alarm
To test an email, icon, or audible alarm that you created inWorkflow Designer, complete the following steps.

1. On thePerceptive Content orWebNow toolbar, click theWorkflow arrow, point to your process, and
then select the queue where you added the alarm.

2. Verify that there are someworkflow items in the queue that meet the conditions you defined in your rule,
and then complete one of the following actions.

Situation Steps

Test an email alarm 1. Check your email account. You should
receive an email with a Subject field of the
name you gave to the alarm and a body text
message such as the following: There are 5
email items in the email queue.

2. Select all the workflow items, right-click,
point toWorkflow, and then clickRoute
Forward.

3. In theRoute Forward dialog box, select a
queue and then clickRoute. This clears the
alarm state for the queue.

Test an audible alarm l Verify the sounds plays if the alarm
condition is true.

Test an icon alarm l Verify the Perceptive Content icon flashes if
the alarm condition is true.
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Routes
What is a route?
A route is one of the basic building blocks of a workflow process.

Routes connect workflow queues. They can be inbound or outbound or both. Routes connect queues
contained in the same process and between processes.

The type of route you define depends on how you need to process items between workflow queues.

Create a route
Routes connect workflow queues. They can be inbound or outbound or both. You can route workflow items to
a queue contained in the same process or to a queue in a different process. To create a route, complete the
following steps.

You can only create load balance, sequential, sequential auto, and parallel routes using the Task Pane. To
create conditional or parallel conditional routes, refer to those topics.

1. InWorkflow Designer, in the Task pane, click Routes.

2. On theGrid toolbar, verify that theNormal Routes button is selected.
3. In theRoutes pane, select a route type.
4. Click on the queue where you want the route to begin and drag your cursor to the queue where you want

the route to end.
5. Repeat these steps to create all routes within your workflow process.

Create a parallel route overview
A parallel route allows multiple actions to take place at the same time on a single workflow item. In a parallel
route, a workflow item is routed tomore than one queue at the same time and when all actions on the item are
complete, the sibling items are routed forward and rejoined in a join queue. To create a parallel route, complete
the following sequence of procedures.

Prerequisite Before completing this sequence of procedures, youmust have at a workflow process with at
least four queues.

1. /1.
2. /1.
3. /1.

Add an outbound parallel route

To add a route out of a queue that routes an item tomultiple queues in parallel, complete the following steps.

1. InWorkflow Designer, double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Routes.
3. In the right pane, on theRoutes Out tab, click Add.
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4. In theAdd Route Out dialog box, do the following substeps.
1. On theGeneral tab, in theName box, type a name for the route.
2. In the Type list, select Parallel.
3. Optional. To enable ad-hoc parallel routing from this queue, select theEnable ad-hoc parallel

routing check box.
If you select this option, when routing forward from this queue, the user can parallel route to one
or more of the queues selected in theAvailable queues list.

5. On theDestination tab, perform the following substeps.
1. In theBusiness Process list, select a process.
2. In theAvailable queues list, select the queues for this parallel route and click Add.
3. Click OK.

6. On theRoutes Out tab, in the route list, verify that the parallel route name and the queues you selected
appear.

7. Click OK until you return toWorkflow Designer.

Remove a route
To remove a route from a queue, complete the following steps.

1. Double-click the queue you want to link to another process.
2. In theQueue Properties dialog box, click Routes.
3. On theRoutes Out tab, select a route, and then click Remove.

Note: You cannot remove conditional or parallel routes from the Route In tab.

4. Click OK.

Delete a route
To delete a route from aworkflow process, complete the following step.

1. InWorkflow Designer, select the route you want to delete.
2. Press DELETE.

Set a default route for a queue
If more than one outgoing route is available for a queue, you can designate one of the routes as the default
route. To set a default route for a queue, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, click Routes.

Note: The default route is automatically set in the Route Forward dialog box.

3. On theRoutes Out tab, in theRoute Name list, select the route you want to set as the default for this
queue and then click Make Default.
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Note: This functionality is not available for routes to super queues. Therefore, super queue routes do
not appear in the Route Name list.

4. Click OK.

Restrict access on a route
You can restrict users and groups from having access to a route in a workflow process. To restrict access on
a route, complete the following steps.

1. Double-click the queue that uses the route you want to modify.
2. In theQueue Properties dialog box, click Routes.
3. On theRoutes Out tab, select the route you want to modify from the list, and then click Modify.
4. In theModify Route Out dialog box, if you are aWorkflow Manager, restrict users from the queue. On

theRestrictions tab, select any users or groups in the available users and available groups lists that
you want to prevent from using this route, and then click Add.

5. Click OK until you return to the process diagram.

Change route style
To change the style of the route arrows in a workflow process diagram, complete the following step.

l On theGrid toolbar, click one of the following route style buttons.
l Orthogonal Routes

l Normal Routes

l Curved Routes

View all the routes for a queue
From the workflow process diagram, you can view all routes for a queue. To view all routes for a queue,
complete the following steps.

1. Open the process containing the queues and routes you want to view.
2. Click to select the queue for which you want to view all the corresponding routes.
Result The routes will appear in bold, easily apparent compared to all other routes in your process diagram.

Work with reason lists
What is a reason list?
Reason lists provide users the ability to indicate why they are putting a workflow item on hold.

When putting an item on hold in a workflow queue, users are prompted to select a reason from a reason list.
As manager of a workflow process, you control the contents of every OnHold reason list. You can define a
reason list as part of a workflow queue's properties.
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Modify or rename a reason list for putting an item on hold
Reason lists are created to provide users with predefined reasons for putting workflow items on hold. To
modify a reason list for putting an item on hold, complete the following steps.

1. Complete one of the following actions, depending on the situation.

Situation Steps

Modify a hold reason list inManagement
Console

1. InManagement Console, in the left pane,
under Select Department, select a
department from the list.

2. In the left pane, clickWorkflow.
3. Click theReason Lists tab.
4. Click the list you want to change and then

clickModify.

Modify a hold reason list inWorkflow Designer 1. Double-click the queue.
2. In theQueue Properties dialog box, click

Reasons in the left pane.
3. In the Select a reason list to use when

placing items On Hold in this queue list,
click the list you want to change and then
clickModify.

2. In theReason List dialog box, on theGeneral tab, change the name and description if necessary.

Note: You cannot change the name of a system list (Apply Signature, Void/Expire Digital ID, or Void
Signature).

3. Tomake the reason list inactive, clear the Is active check box.

Note: You cannot disable a system list.

4. In the List Members tab, add, remove, or rearrange reasons.
5. Click OK.

Add a reason list for putting an item on hold
When putting an item on hold in a workflow queue, the user must select the reason for the change from a
reason list. To create and edit a reason list, complete the following steps.

1. Complete one of the following actions, depending on the situation.
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Situation Steps

Create a hold reason list in Perceptive Content 1. In Management Console, in the left pane,
under Select Department, select a
department from the list.

2. In the left pane, clickWorkflow.
3. On theReason Lists tab, clickNew.

Create a hold reason list inWorkflow Designer 1. InWorkflow Designer, double-click the
queue.

2. In theQueue Properties dialog box, click
Reasons > New.

2. In theReason List dialog box, type a name and optional description for the reason list and then leave
the Is active check box selected.

3. On the List Members tab, add, remove, and rearrange reasons as necessary.
4. Click OK.

Work with statistics
What are statistics?
Statistics are calculations such as themaximum, minimum, and average of all the values in a specific column
that appear in the search results for the view.

You can define statistics for any document view, folder view, task view, record view, or record folder view for
which you havemanagement privileges. You cannot define statistics for a public filter or a related view.

For any folder type for which you havemanagement privileges, you can create a view that determines the
appearance of the folder content results in Folder Viewer. You can also create a statistic for a workflow view,
which defines the appearance when viewing the contents of a workflow queue. When you define a set of
statistics for a folder content or workflow view, the statistics appear in a pane below the search results grid. In
the statistics pane, you can view the statistics, highlight the search results in the grid that apply to the
statistic, and, if only one document or folder matches the statistic value, open the document or folder.

The following examples demonstrate someways you can use view statistics.

Accounts Payable: Theresa is an Accounts Payable administrator who wants to quickly view the total
of all the invoices in her "OpenInvoices" view. This view contains a custom property columnwhich
stores the invoice amount for each document. Because it is a numeric custom property, Theresa adds
a Sum statistic on this custom property column named "Total open amount". Every time she runs a
search using this view, she sees the total invoice amount of all the documents returned by the search
in the statistics pane.
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Admissions: Sam is an Admissions director who wants to view the average ACT score of the students
who applied to his university in the current academic year. His student folder view contains a custom
property columnwhich stores the ACT score for each student and a date range that spans the current
academic year. Because the view uses a numeric custom property, Sam adds an Average statistic on
this custom property column named "Average ACT."

Healthcare: Dr. Lovelace wants to quickly view the next task he is responsible for in his folder view
that lists all his patients with document deficiencies. His view administrator adds a Next statistic to
the task due date column in the view. When Dr. Lovelace logs in, he can quickly see the date the next
task is due, highlight the document associated with the task, and open it in ImageNowViewer.

To view records functionality, youmust install a Records Manager license.

Data types for statistical functions
The statistical functions you can define depend on the data type of the column values. To add a statistic for a
custom property column, youmust first add the custom property column to the view. The following statistics
are available for the specified data types.

Statistical functions

Average
This function calculates the average of the column values.

Column value data type

Numeric

Sample columns

Summary Task Count

<Number custom property>

Count
This function counts the number of values in the search results grid that match the selected variable
(you must select a variable for this statistical function).

Column value data type

String, list, flag
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Sample columns

Folder Name

InWorkflow

<List custom property>

<String custom property>

<Flag custom property>

Count Future
This function counts the number of the column's date values that occur in the future.

Column value data type

Date

Sample columns

Next Task Due

DueDate

<Date custom property>

Count Past
This function counts the number of the column's date values that occur in the past.

Column value data type

Date

Sample columns

Created

Last Viewed

<Date custom property>

First
This function distinguishes the earliest date in the column's search results.

Column value data type

Date
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Sample columns

Modified

CheckedOut

<Date custom property>

Last
This function distinguishes the latest date in the column's search results.

Column value data type

Date

Sample columns

Checked In

Assigned

<Date custom property>

Maximum
This function distinguishes the largest numeric value in the column's search results.

Column value data type

Numeric

Sample columns

Pages

<Number custom property>

Median
The function distinguishes the middle value in the column's search results.

Column value data type

Sample columns

Current Version

<Number custom property>

Minimum
This function distinguishes the smallest numeric value in the column's search results.
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Column value data type

Numeric

Sample columns

Days Until Due

<Number custom property>

Mode
This function distinguishes the most frequently occurring numeric value in the column's search
results.

Column value data type

Numeric

Sample columns

Summary Task Count

<Number custom property>

Next
This function distinguishes the next sequential date value in the column's search results.

Column value data type

Date

Sample columns

Status Changed

<Date custom property>

Previous
This function distinguishes the previous sequential date value in the column's search results.

Column value data type

Date

Sample columns

Completed

<Date custom property>

Sum
This function calculates the total of the values in the column's search results.
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Column value data type

Numeric

Sample columns

Pages

<Number custom property>

Add view statistics overview
The configuration of a view statistic differs based on the data value type you select. You can create statistics
for document, folder, folder content, record, task, and workflow views. To create a statistic for a view,
complete any of the following procedures.

l /1.
l /1.
l /1.
l /1.
l /1.

Add a statistic for a date value

You can display the newest, oldest, or next date value in a list of search results, or display the total number of
dates in the past or dates in the future. To add a statistic for a date value, complete the following steps.

Prerequisite Before you can add a statistic for a date custom property value, youmust first add the custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.
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Situation Steps

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to view the next task due date, type Next task due.

5. UnderColumn, select the view columnwith the date values.
6. Under Function, select one of the following options depending on the display variable you want to

show:

Situation Steps

Total number of dates in the future l Select Count Future.

Total number of dates in the past l Select Count past.

Oldest date value l Select First.

Newest date value l Select Last.

The next future date l Select Next.

The most recent date l Select Previous.

7. Optional. UnderCaption, select the value to display when the statistic only applies to one search
result.
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Example If aPrevious statistic shows the last viewed item, and you want to quickly display the user
name of the user who viewed the item, you can use theCaption column to select the Last Viewed By
user.

8. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

9. Click OK.
The statistic appears below the grid in thePreview pane.

10. In thePreview pane, click theRun button to test the statistic's performance.

Add a statistic for a flag value

You can add a statistic that distinguishes the number of search results that have a true or false (boolean)
value. To add a statistic for a flag value, complete the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, youmust add the flag custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.
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2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to count the number of documents or records assigned to a retention
policy, type Documents in Retention or Records in Retention.

5. UnderColumn, select the view columnwith the flag values.
6. Under Function, select Count.
7. UnderVariable, select whether you want to count the results that meet the TRUE condition or the

FALSE condition.
8. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If there is one version-controlled item in your search results, and you want to quickly display
the user whomarked the item private, you can use theCaption column to select thePrivate By user.

9. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

10. Click OK.
The statistic appears below the grid in thePreview pane.

11. In thePreview pane, click theRun button to test the statistic's performance.

Add a statistic for a list value

You can add a Count statistic that distinguishes a unique value of a list custom property. To add a statistic for
a list value, complete the following steps.

Prerequisite Before you can add a statistic for a list value, youmust first add the list custom property
column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.
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Situation Steps

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If you have a list custom property to select the fiscal quarter associated with an invoice and
you want to add a statistic to show fourth quarter invoices, type Invoices in Q4.

5. UnderColumn, select the list custom property.
6. Under Function, select Count.

Note: Count is the only statistical function for list values.

7. In theVariable list, select an item from the list to use for the statistic.
8. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If there is only one item added to workflow during themonth of January, and you want to
quickly display the user who added the item to workflow, you can use theCaption column to select the
workflow user.

9. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

10. Click OK.
The statistic appears below the grid in thePreview pane.

11. In thePreview pane, click theRun button to test the statistic's performance.
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Add a statistic for a numeric value

You can display the average, sum, median, or mode statistic that distinguishes numeric values, such as the
number of tasks or a custom property that stores an amount value. To add a statistic for a numeric value,
perform the following steps.

Prerequisite Before you can add a statistic for a flag custom property value, youmust add the flag custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to view the average amount of invoices, type Average invoice
amount.

5. UnderColumn, select the view columnwith the flag values.
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6. Under Function, select the display variable you want to show.
7. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If aMaximum statistic displays the invoice with the highest amount, and you want to quickly
display the user name of the user who last viewed the invoice, you can use theCaption column to
select the Last Viewed By user.

8. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

9. Click OK.
The statistic appears below the grid in thePreview pane.

10. In thePreview pane, click theRun button to test the statistic's performance.

Add a statistic for a string value

You can add a non-case sensitive Count statistic that distinguishes string values, such as a task template or
drawer name. To add a statistic for a string value, which you can add at the view or filter level, perform the
following steps.

Prerequisite Before you can add a statistic for a flag custom property value, youmust add the flag custom
property column to the view.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.
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Situation Steps

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click Add.
4. Under Label, type a label that describes the statistical function to appear in the search results grid.

Example If adding a statistic to count the number of items scanned by the department manager, type
Scanned by Manager.

5. UnderColumn, select the view columnwith the string values.
6. Under Function, select Count.

Note: Count is the only statistical function for string values.

7. UnderVariable, type the value for the statistic, such as the drawer name or task template name.
8. Optional. UnderCaption, select the value to display when the statistic applies to only one search

result.

Example If there is only one items for a specific vendor in your workflow process, and you want to
quickly determine if it is an invoice or a purchase order, you can use theCaption column to show the
Document Type.

9. Optional. To reorder the statistic, click theMove Up orMove Down button until the statistic reaches
the desired position.

10. Click OK. The statistic appears below the grid in thePreview pane.
11. In thePreview pane, click theRun button to test the statistic's performance.

Modify a statistic
Tomodify the components of a statistic defined for a view, complete the following steps.

1. Access the view preview using one of the followingmethods.

Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.
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Situation Steps

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button and then, in theStatistics dialog box, click the row of
the statistic you want to change.

3. Do one of the following actions.
l To change the statistic definition, highlight the statistic row and thenmodify the components you
want to change.

l To reposition the statistic, click Move Up to move it ahead of the preceding statistic, or click Move
Down to move it after the following statistic.

4. Click OK.
5. In thePreview pane, click theRun button to test the statistic's performance.

Remove a statistic
To remove a statistic from a view, complete the following steps.

1. Access the view preview using one of the followingmethods.
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Situation Steps

Create a date statistic for a view 1. Open the view in View Designer.
2. In View Designer, clickView > Preview.

Create a date statistic for a container content
view

1. InManagement Console, in the left pane,
select Folder Types.

2. In the right pane, select the folder type and
clickModify.

3. In the Folder Type dialog box, on the
Appearance tab, click the Preview button.

Create a date statistic for a workflow queue view 1. Open the workflow process inWorkflow
Designer.

2. Double-click the queue to open theQueue
Propertieswindow.

3. In theQueue Propertieswindow, in the left
pane, select Appearance.

4. In the right pane, clickPreview.

Create a date statistic for a workflow process
view

1. Open the workflow process inWorkflow
Designer.

2. Click File > Properties.
3. In the Process Properties dialog box,

underAppearance, clickPreview.

2. In thePreview pane, click theStatistics button.
3. In theStatistics dialog box, click the row of the statistic you want to remove and click Remove.
4. Click Yes in the confirmation prompt and then, in theStatistics dialog box, click OK.
Result Removing a statistic does not remove the column from the view.

Work with rules and scripts
What are rules and scripts?
Rules and scripts help youmanage items as youmove them through workflow queues.

InWorkflow Designer, rules let you create conditional alarms and routes. Typically, you would use workflow
rules to set up alarms and to route items through your work queues. You can create rules and specify
conditions in order to trigger an event on a queue. There are two types of rules: Routing and Alarm. Once you
have created your rules, you set the order in which you want to apply them, and then you activate them.
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Scripts are typically used when you want to automate actions such as to printing, faxing or emailing. You
might also use a script to strip elements from a numeric string, such as slashes from a telephone number or
hyphens from a social security number.

You can define rules and scripts as part of a queue's properties.

Add a rule action to a queue
To add a routing or alarm rule to a workflow queue as a within queue action, complete the following steps.

1. Double-click the queue.
2. In theQueue Properties dialog box, in the left pane, do one of the following actions.

Situation Steps

To add a routing rule to the queue 1. ClickActions.
2. In the right pane, on theWithin Queue tab,

in theAction list, select the routing rule.
3. Optional. Set a waiting period that must

elapse before the action is executed by
selecting or typing a number in the Skip
items in queue less than box, and then in
the list, select the duration type of minutes,
hours, or days.

To add an alarm to the queue 1. ClickAlarms.
2. In the right pane, clickAdd.
3. In the Select Alarm dialog box, clickNew.
4. In theAlarm Settings dialog box, type a

name for the rule.
5. Verify the Status is set toActive.
6. In theAlarm rule list, select the alarm rule

and clickOK.
7. In the Select Alarms dialog box, select the

alarm and clickAdd.

Note: The Timeout Period for alarm rules only applies if the client loses communication with Alarm
Agent. Contact Perceptive Software Product Support before changing this setting.

3. Click OK until you return toWorkflow Designer.
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Rules

Create a conditional route overview

To route items between workflow queues based on a set of conditions, complete the following procedures.

1. /1.
2. /1.
3. /1.
4. /1.
5. /1.
6. /1.

Create a routing rule

To create a routing rule used to route items between workflow queues, complete the following steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.
3. In theAction Settings dialog box, on theRules tab, click New.
4. In theRules Editor, in theRules name box, type a name.
5. Click OK until you return toWorkflow Designer.

Add a rule statement

To copy a statement for a workflow routing rule to simplify new statement creation, complete the following
steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.
3. In theAction Settings dialog box, on theRules tab, select the rule you want to modify and then click

Modify.
4. In theRules Editor, underStatements, click New.
5. In theStatement Editor, edit the rule name, define conditions, and set statement actions.
6. Click OK until you return toWorkflow Designer.

Modify rule statement conditions

Tomodify the conditions associated with a statement that is part of a workflow routing rule, complete the
following steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.
3. In theAction Settings dialog box, on theRules tab, select the rule you want to modify and then click

Modify.
4. In theRules Editor, underStatements, select a statement and click Modify.
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5. In theStatement Editor, complete any of the following actions.

Situation Steps

Add statement conditions 1. UnderConditions, click theAdd button
and create the conditions you want to use
with this rule.

2. Repeat step for each condition you want to
create.

Change statement conditions 1. UnderConditions, double-click the
condition and modify the condition.

2. Repeat step for each condition you want to
change.

Remove statement conditions 1. UnderConditions, select the condition.

2. Click theDelete button.
3. Repeat steps for each condition you want to

delete.

Reorder statement conditions 1. UnderConditions, select the condition.

2. Click theMove Up orMove Down
button.

3. Repeat step for each condition you want to
change.

Group or upgroup statement conditions 1. UnderConditions, select the condition or
conditions.

2. Click theGroup orUngroup button.
3. Repeat step for each condition you want to

change.

Change a statement condition operator l UnderConditions, click theAND orOR
operator.

6. Click OK until you return toWorkflow Designer.

Modify a routing rule statement action

To tomodify the action for a statement in a workflow routing rule, complete the following steps.

1. InWorkflow Designer, in theActions pane, click Manage Actions.
2. In theAction Settings dialog box, on theRules tab, select the routing rule you want to modify and click

Modify.
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3. In theRules Editor dialog box, underStatements, select the statement and click Modify.
4. In theStatement Editor, underActions, select the action and click Modify.
5. If modifying a routing action, in theQueues dialog box, as necessary, select a workflow process and

add or remove queues.
6. If modifying aSet custom property action, in theSet Custom Property dialog box, as necessary,

select a custom property from the list and then, underSet value to, complete one of the following
options.
l In theSupplied value field, type a value or select one from the list.
l To set the selected property to another property of the same type, select Property and then select
a value from the list.

You cannot set a list or flag custom property to a property of the same type. To set a property to a blank
value, leave the field blank or select the blank value from the list.

7. Click OK to return to theRules Editor.
8. In theRules Editor, if you havemore than one statement, reorder the statements as necessary.

Statement processing stops after any statement evaluates true, so the order of the statements is
important if an item could evaluate true for more than one statement. The statement order determines
the processing priority.

9. UnderStatus, click Active and then click OK until you return toWorkflow Designer.

Activate a rule

Tomake a routing or alarm rule active, complete the following steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.
3. In theAction Settings dialog box, on theRules tab, select the rule you want to modify and then click

Modify.
4. In theRules Editor, underStatus, select Active.
5. Click OK until you return toWorkflow Designer.

Create a conditional route

To create an outbound route for a workflow that routes item to specified queues based on a condition,
complete the following steps.

1. Double-click the queue.
2. In theQueue Propertieswindow, in the left pane, click Routes.
3. In the right pane, on theRoutes Out tab, click Add.
4. In theAdd Route Out dialog box, on theGeneral tab, in theName box, type a name for your route.
5. In the Type list, select Conditional.
6. Optional. In theConditions list, select Edit Rules.... In theRules dialog box, complete any of the

following substeps.
1. To create a new rule, click New..., and in theRules Editor dialog box, define the Rule name,

Rule type, and Statements for the rule, and click OK..
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2. Tomodify an existing rule, select the rule, and click Modify. In theRules Editor dialog box, edit
the Rule name, Rule type, and Statements for the rule, and click OK.

3. To share the rule with another department, click Share. In theShare <Rule name> dialog box,
check the boxes of the departments you want to share the reason list with, and then click OK.

7. In theCondition list, select the conditional routing rule.
8. Click OK until you return toWorkflow Designer.

Create a conditional parallel route overview

A conditional parallel routing rule is evaluated when youmanually route an item forward. To create an outgoing
conditional parallel route for a workflow queue, complete the following sequence of procedures.

1. /1.
2. /1.
3. /1.
4. /1.

Create a conditional parallel routing rule

To create a routing rule you can define for a conditional parallel route, complete the following steps.

1. InWorkflow Designer, in theActions pane, click Manage Actions.
2. In theAction Settings dialog box, on theRules tab, click New.
3. In theRules Editor dialog box, in theRule name box, type a name.
4. In theRule type box, click Routing rule.
5. UnderStatements, click New and complete the following substeps.

1. In theStatement Editor, in theStatement name box, type a name.

2. UnderConditions, click theAdd button and create the conditions you want to use with this
rule.

6. UnderActions, complete any of the following steps.
1. To route the workflow items to a queue when the itemmeets the conditions, click Add > Route

To.
2. To set a custom property value when the itemmeets conditions, click Add > Set custom

property.
7. If routing to a queue, in theQueues dialog box, select a workflow process and queue and click Add.
8. If setting a custom property value, in theSet Custom Property dialog box, select a custom property

from the list and then, underSet value to, complete one of the following options.
l In theSupplied value field, type a value or select one from the list.
l To set the selected property to another property of the same type, select Property and then select
a value from the list.

You cannot set a list or flag custom property to a property of the same type. To set a property to a blank
value, leave the field blank or select the blank value from the list.

9. Click OK to return to theRules Editor.
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10. In theRules Editor, if you havemore than one statement, reorder the statements as necessary.
Statement processing stops after any statement evaluates true, so the order of the statements is
important if an item could evaluate true for more than one statement. The statement order determines
the processing priority.

11. UnderStatus, click Active and then click OK until you return toWorkflow Designer.

Create a conditional parallel route

To create an outbound route that conditionally routes a workflow item in parallel to another queue, complete
the following steps.

1. Double-click the queue for which you want to create the outbound route.
2. In theQueue Properties dialog box, in the left pane, click Routes.
3. In the right pane, on theRoutes Out tab, click Add.
4. In theAdd Route Out dialog box, on theGeneral tab, in theName box, type a name.

1. In theCondition list, select the conditional parallel route you created in the previous procedure
and click OK.

5. In the Type list, select Conditional Parallel.
6. Optional. In theConditions list, select Edit Rules.... In theRules dialog box, complete any of the

following substeps.
1. To create a new rule, click New..., and in theRules Editor dialog box, define the Rule name,

Rule type, and Statements for the rule, and click OK..
2. Tomodify an existing rule, select the rule, and click Modify. In theRules Editor dialog box, edit

the Rule name, Rule type, and Statements for the rule, and click OK.
3. To share the rule with another department, click Share. In theShare <Rule name> dialog box,

check the boxes of the departments you want to share the reason list with, and then click OK.
7. In theCondition list, select the conditional routing rule.
8. In theQueue Properties dialog box, click OK.

Test conditional parallel routing

To determine whether items are evaluated and routed in correctly in a conditional parallel process, complete
the following steps.

1. Add an item to the first queue in your parallel workflow process.
2. Route the workflow item through the conditional route.
3. Ensure that the workflow item siblings end up in the correct queues according to whether the workflow

itemmet the conditional rule.
4. In the parallel queues, verify that each parallel queue has a sibling of the workflow item that is supposed

to have a sibling.
5. In the parallel queues, route each sibling to the Join queue in the process.
6. In the queue you designated as the Join queue, verify that the workflow siblings have joined together. If

you seeWaiting for siblings
, then at least one sibling still needs to be routed to the Join queue.
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Create an out of office event rule overview

To create a routing or alarm rule for use with an out of office event in workflow, complete the following
procedures.

1. Verify the queue user has an active out of office event configured inManagement Console.
2. /1 or /1.
3. /1.
4. /1.
5. Optional. /1.
6. /1.
7. /1.
8. /1.
9. /1.

10. /1.

Create an out of office rule statement condition

To create a condition for a statement associated with an out of office alarm or routing rule in workflow,
complete the following steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.
3. In theAction Settings dialog box, on theRules tab, select the rule you want to modify and then click

Modify.
4. In theRules Editor, underStatements, complete one of the following options.

l To add the out of office condition to an existing statement, select the statement and click Modify.
l To add the out of office condition to a new statement, click New.

5. In theStatement Editor, underConditions, click theAdd button and then, in theAdd Condition
dialog box, complete the following substeps.
1. In theConstrain by list, select Status.
2. In the Field list, select Queue is unattended.
3. In theOperator list, select is equal to.
4. In theValue list, select Yes.
5. Click OK.

6. Click OK until you return toWorkflow Designer.
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Modify a rule overview

From the Rules Editor, you can create statements, change the order of statements, change the attributes of a
statement, remove statements, or disable rules. Tomodify a rule, complete any of the following procedures.

l /1.
l /1.
l /1.
l /1.
l /1.
l /1.

Routing and alarm rule conditions

The following tables contain the condition and action options for routing and alarm rules inWorkflow Designer.
Applied as inbound, within queue, or outbound actions, rule conditions are evaluated as you route items into,
within, or out of workflow queues. A rule can contain multiple conditions and actions. To activate a rule, you
must configure at least one condition and one action.

Conditions

To automatically route a workflow item or to trigger an alarm, youmust define a condition. The following table
lists conditions, explains whether the condition is available for routing or alarm rules, lists configuration
criteria, and gives an example of how to use the condition. By default, the condition under the Required for
Alarm Rules columnmust be configured with the alarm condition.

If you delete an element used in a rule condition, such as a document type or a workflow queue, Workflow
Designer automatically disables the rule. In the Statement Editor for the routing or alarm rule, the disabled
condition appears as (invalid condition).

Content property
A property value associated with a workflow item, such as a document key or type.

Type

Routing rule

Alarm rule

Criteria

Select Drawer, Field1, Field2, Field3, Field4, Field5, Document type, Name, or Type

To use a custom property as a routing condition, define a custom property that is directly assigned to the
document or folder type and that is not part of a composite custom property. If you define a composite
property as a routing condition, that condition is evaluated as FALSE and the items are not routed.
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Example

IF Drawer is equal to Default

Custom property
A custom property value associated with a workflow item.

Type

Routing rule

Alarm rule

Criteria

is equal to, is not equal to, is less than, is greater than, is less than or equal to, is greater than or equal to

Example

IF Amount is equal to 100

Status
A status associated with the workflow item.

Type

Routing rule

Alarm rule

Criteria

Select Has required documents, Folder status, Digital signature status, Summary task status, Item
priority, or Queue is unattended

Example

IF Priority is equal to Low

Task property
A property of a task associated with the workflow item.

Type

Routing rule

Alarm rule

Criteria

Select Task due date, Task status, Summary task due date, or Summary task status
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Example

IF Task state is equal to any task with state Assigned

User
A user who performs an action on the workflow item.

Type

Routing rule

Alarm rule

Criteria

Select Created by, Digital signature user, or Routing user

Example

IF Creation user is equal to LWalker

Workflow item property
A property of the item in the workflow process or queue.

Type

Routing rule

Alarm rule

Criteria

Queue item count, Creation time, Time in queue, or Routed from queue

Example

IF Time in queue is equal to 2 Days

Actions

To complete a rule statement, youmust select an action. You can use the routing actions to specify the queue
where an item is routed and to set a custom property value for that item. With alarm rules, you choose the
type of alarms you want users to receive. The following table lists actions, explains whether the condition is
available for routing or alarm rules, lists configuration criteria, and gives an example of how to use the
condition.

Route to <specified queue>
Route to a specific queue if rule conditions are met, such as IF the queue contains at least
<X> workflow items.
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Type

Routing rule

Criteria

Select any queue from an existing process.

Example

THEN Route to Insurance: Approved

Set custom property
Set a custom property value if rule conditions are met, such as IF the queue contains at
least <X> workflow items.

Type

Routing rule

Criteria

Select a date, number, string, flag, list, or user custom property

Example

ALWAYS Set custom property Invoice Status to 'Paid'

Send <email>
Send an email if rule conditions are met, such as IF the queue contains at least <X>
workflow items.

Type

Alarm rule

Criteria

Enter alarm name, e-mail header information, e-mail message, and select e-mail interval.

Example

THEN E-mail Heads up!

<Message Center>
Display a message in the Message Center if rule conditions are met, such as IF the queue
contains at least <X> workflow items.

Type

Alarm rule
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Criteria

Enter alarm name, message title, andmessage body.

Example

THEN Notify Time's up

Flash <icon>
Flash the ImageNow icon if rule conditions are met, such as IF the queue contains at least
<X> workflow items.

Type

Alarm rule

Criteria

Enter alarm name, choose alarm color, and alarm frequency.

Example

THEN Flash icon Ready for Review

Play <sound>
Play an audible alarm when rule conditions are met, such as IF the queue contains at least
<X> workflow items.

Type

Alarm rule

Criteria

Enter alarm name, choose aWAV file, and play interval.

Example

THEN Play sound Limit Exceeded

Remove a rule

To remove a rule from aworkflow process, complete the following steps.

1. From theWorkflow DesignerTask pane, click Actions.
2. In the Task pane, click Manage Actions.
3. In theRules dialog box, select the rule you want to remove, and then click Remove.
4. When prompted to verify that you want to remove this rule, click Yes.
5. Click OK and return toWorkflow Designer.
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Reorder rule statements

Tomodify a workflow routing rule by reordering the statements in the rule, complete the following steps.

1. InWorkflow Designer, in the Tasks pane, click Actions.
2. Click Manage Actions.
3. In theAction Settings dialog box, on theRules tab, select the rule you want to modify and then click

Modify.
4. In theRules Editor, underStatements, select a statement.
5. Click Move Up orMove Down as necessary.
6. Click OK until you return toWorkflow Designer.

Scripts

Add a script to a process

To add a script to a workflow process, complete the following steps.

1. From theWorkflow Designer task pane, click Actions.
2. In the task pane, click Manage Actions.
3. In theAction Settings dialog box, click the iScripts tab.
4. On the iScripts tab, click Add.
5. On theSelect iScripts dialog box, select the server script you want to add, and then click OK until you

return toWorkflow Designer.
Result You do not need to restart Workflow Agent or any other server agents after you add an iScript in
Workflow Designer.

Remove a script

To remove a script from a queue, complete the following steps.

1. Double-click the queue from which you want to remove a script.
2. In theQueue Properties dialog box, click Actions.
3. In theAction list containing the script you want to remove, click Edit Actions.
4. In theAction Settings dialog box, on the iScripts tab, select a script, and then click Remove.
5. Click OK until you return toWorkflow Designer.

Run a script upon opening a workflow item

You can create a VBScript that executes each time a workflow item is open. This is a global script that
executes for all workflow queues in all workflow processes that exist on the ImageNow Server you are
running. To run a script upon opening a workflow item, complete the following steps.

1. Open a workflow item.
2. In ImageNowViewer orWebNowViewer, clickWorkflow > Page Load Script.
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3. In theWorkflow Page Load Script dialog box, type in your VBScript, and then click OK.
4. Close the item, and then in the confirmation box, click Yes.
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